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Important Information

Safety Information
1  Important Information

1.1  Safety Information

The following information is intended for service personnel and authorized 
specialists. Only these persons are permitted to work on the installation.

Read through all information on the equipment carefully, and follow all safety 
instructions. Make sure you know the emergency numbers.

Always contact your supervisor before starting work if the necessary safety 
measures do not appear to be in place (e. g. risk of gas explosion, humidity).

Safety symbols

This manual uses the following symbols to indicate potential hazards:

NOTE:  This symbol identifies useful information.

Further symbols for defining the source of danger in greater detail1:

Electricity Weight Heat Fire Chemicals ESD* Laser

* Electrostatically Sensitive Devices

This symbol warns that a situation may cause death or 
serious injury.

This symbol indicates hazard which may lead to serious 
injury.

This symbol indicates a risk of damage to hardware or software.

1. These symbols are not generally used in this manual. They’re an explanation of the symbols that 
can be depicted on the systems.
P31003-H3231-S100-01-7620, 10/2022
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Safety Information
1.1.1  Safety Information:  Danger

• Before starting the installation and connecting the subscribers, the installation 
must be correctly connected to the protective conductor. 
Never operate the equipment with the ground wire disconnected.

• Voltages above 30 V AC (alternating current) or 60 V DC (direct current) are 
dangerous.

• If the power cable appears to be damaged, replace it immediately.

• Immediately replace any damaged safety equipment (covers, labels and 
protective cables).

• If maintenance work requires the power supply of the system to be shut down, 

– use the shut-off switch to disconnect the system from the power supply 
circuit and secure the disconnect device mechanically so that it cannot be 
used by other persons. 

– Attach a sign reading “DO NOT OPERATE” to the disconnect device. 
A disconnect device can be a shut-off switch (main switch) or circuit-
breaker (fuse/automatic circuit-breaker). 

– Before starting any work on the installation, find out where the system’s 
disconnect device is located. 

• If you are performing work on circuits with hazardous voltages, always work 
together with a partner who is familiar with the location of the switch for the 
power supply. 

• Always ensure adequate insulation when touching powered circuits. 

• Ensure that the installation is not powered by an additional power supply, or 
protected via an additional fuse or additional main switch.

• Before starting any work, check whether the corresponding circuits are still on 
power. Never take it for granted that all circuits have reliably been 
disconnected from the power supply when a fuse or a main switch has been 
switched off. 

• During a thunderstorm, you should not connect or remove telephone lines or 
boards.

• Expect to encounter leakage current from the telecommunication network.

• Ensure that, whenever work is carried out on an open installation, the 
installation is never left unsupervised.
 P31003-H3231-S100-01-7620, 10/2022
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1.1.2  Safety Information:  Warning

• There is the risk of an explosion if the lithium battery is not replaced correctly. 
The lithium battery must be replaced only by the same or equivalent types 
recommended by the dealer.

• Be aware of additional dangers with low voltages and large cross-sections. 
Cables with a large cross-section generally have lower voltages, although the 
current strengths are higher. This is particularly dangerous, e.g. in the event 
of short circuits.

• When working on the installations, never wear loose clothing and always tie 
back long hair. 

• Never wear jewelry, for example or metal watch straps,  metal fittings or metal 
rivets on items of clothing. There is a risk of injury and short circuits.

• The surface of a mirror is conductive.  Never touch powered components with 
a mirror; you may injure yourself and/or at least cause short-circuit damage. 

• Always wear the necessary eye protection whenever appropriate.

• Always wear a protective helmet where falling objects might injure you.

• Always disconnect the power supply when you are working directly next to a 
power supply unit or direct current converter, unless the work instructions 
expressly permit you to work without shutting off the power. 

• Never try to lift heavy objects without assistance.

• Never look directly at a laser beam.

1.1.3  Safety Information: Caution

• Check the nominal voltage set for the equipment (operating instructions and 
type plate).

• As long as the power supply is switched on, always observe the greatest 
caution when performing measurements on powered components and 
maintenance work on plug-in cards, boards and covers. 

• To protect electrostatically sensitive devices (ESD):

– Wear a wristband before carrying out any work on PC boards and 
modules. Connect the alligator clip at the end of the electrostatic 
wristband wire to a grounded object.

– Transport PC boards only in suitable protective packaging.

– Always place PC boards on a grounded conducting base, and do not work 
on the PC boards anywhere else.
P31003-H3231-S100-01-7620, 10/2022
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Safety Information
– Only use grounded soldering irons.

• Only use tools and testers suitable for the job. Do not use broken tools and 
testers, inspect them regularly.

• Locate the main switch for the power supply and follow the instructions affixed 
to it. 

• Cables should be installed so that they do not pose an accident risk (i.e. will 
not trip anybody up) or are damaged.

1.1.4  General Information

• If the installation is brought into the operating site from a cold environment, 
condensation may occur. Wait until the temperature of the installation has 
adjusted to the ambient temperature and until the installation is absolutely dry 
before you start it up.

• Before starting wall assembly, check whether the load-bearing capacity of the 
wall is adequate, e. g. in the event of plasterboard walls.

• When the installation or maintenance is completed, replace all safety 
equipment in the correct location. 

• Check your tools regularly. Only use intact tools. 

• Close the doors after finishing testing, maintenance, or installation.

• All cables and lines which leave a system cabinet must be screened at least 
between the connection point in the cabinet and the point at which the cable 
leaves the cabinet.
Use a clip and pressure screw to contact all shield fabric to the cabinet outlet. 
This also applies to permanently connected service equipment.

• Cables should only be connected to the specified connection points.

• Do not install any external modems in the installation cabinets. 

• Do not allow flammable materials to be stored near the installation or in the 
installation room. 

• Ensure good lighting at the workplace. 

• Untidiness at the workplace involves the risk of injuries.
 P31003-H3231-S100-01-7620, 10/2022
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1.1.5  What To Do in an Emergency

• In the event of accidents, remain calm and controlled.

• Always switch off the power supply before you touch an accident victim. 

• If you are not able to switch off the power supply immediately, only touch the 
victim with non-conducting materials (e. g. a broom handle made of wood), 
and first of all try to isolate the victim from the power supply. 

• You must be familiar with first-aid practices in the event of electricity injuries. 
A fundamental knowledge of the various resuscitation methods if the victim 
has stopped breathing or if the victim’s heart is no longer beating, as well as 
first aid for treating burns, is absolutely necessary in such emergencies. 

• If the victim is not breathing, immediately perform mouth-to-mouth or mouth-
to-nose resuscitation. 

• If you have appropriate training, immediately perform heart massage if the 
victim’s heart is not beating. 

• Immediately call an ambulance or the emergency doctor. Provide the 
following information in the following sequence:

– Where did the accident take place?

– What happened?

– How many people were injured?

– What type of injuries?

– Wait for questions.

1.1.6  Reporting Accidents

• Immediately report all accidents, “near accidents” and potential sources of 
danger to your manager. 

• Report all electrical shocks, no matter how small.
P31003-H3231-S100-01-7620, 10/2022
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1.2  Data Protection and Data Security

This system also processes and uses personal data,
e.g. for call charge metering purposes, displays and for recording subscriber 
data.

In Germany, the processing and use of such personal data are subject to various 
regulations, including the regulations of the Federal Data Protection Law 
(Bundesdatenschutzgesetz = BDSG). Observe all applicable laws in other 
countries.

The aim of data protection is to ensure that the rights of individuals are not 
infringed upon through the use of their personal data.

By protecting data against misuse during all stages of processing, privacy 
legislation also protects the material interests of the individual and of third parties.

Members of Unify and Unify Rolm staff are required to observe business and data 
secrecy as a result of the company’s work rules.

In order to ensure that the statutory requirements during service – (whether on-
site or remote) – are consistently met, you should always observe the following 
rules. This safeguards the interests of the customer and offers added personal 
protection.

Contribute to data protection and data security with your conscientious 
action: 

• Ensure that only appropriately authorized persons have access to customer 
data.

• Take full advantage of password allocation options; do not inform un 
authorized persons of passwords, e.g. by means of a written note.

• Ensure that no un authorized person is able to process (store, modify, 
transmit, disable, delete) or use customer data in any way.

• Prevent unauthorized persons from gaining access to data media, e.g. on 
backup diskettes or log printouts. This applies to service calls as well as to 
storage and transport.

• Ensure that data media which are no longer required are completely 
destroyed. Ensure that documents are not generally available.

Work together with your contacts at the customer’s company: this creates 
mutual confidence and reduces your own workload. 
 P31003-H3231-S100-01-7620, 10/2022
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1.3  Typographical Conventions

1.

2.

For the sake of clarity the following typographical conventions have been used 
throughout this manual:

indicates important information on the correct handling of the system.

bold font indicates commands or menu items

italic font indicates paths or program names

lists steps that you must execute
P31003-H3231-S100-01-7620, 10/2022
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General Information
2  Introduction

BLF-Win (Busy Lamp Field) is a control and display program that provides 
information on the status of the subscribers or subscriber groups configured in a 
telephone system.

2.1  General Information

The Busy Lamp Field program displays the ringing states of the configured 
subscribers and subscriber groups.

The main functions of the BLF-Win client are:

• Color status indicator of the subscriber line:

– Idle

– Ringing

– Out of service

– Busy

– not existing

• Customized configuration and design of the program window

• Configuration of subscribers and subscriber ranges

• Call forwarding

• Note function provided when subscribers and subscriber ranges are created. 
The note appears in the fast tip.

• Networkwide solution: 

– One BLF-Win Server can handle more switches in corporation with CAP 
V3.0 SCCP interface. Note, that the iBLF server can only handle the 
switch it is running on.

– One BLF-Win Client can handle more switches in corporation by 
connecting to multiple iBLF and BLF-Win servers.

Note:

BLF-Win 3.0 does not support 

• Hunt groups

• Executive/Secretary combination
P31003-H3231-S100-01-7620, 10/2022
BLF-Win, Service Manual 13

         



Introduction

BLF_Win_SM_ch02.fm

BLF-Win Documentation
• ISDN-access

For a detailed description of the functions, please refer to the BLF-Win operating 
manual.

2.2  BLF-Win Documentation

The BLF-Win documentation describes version 3.0 R19 and consists of two parts:

• BLF-Win Client Operating Instructions

• BLF-Win Server Service Manual (this manual)

The service manual covers the following:

• Instructions on how to set up the connection to the CAP server

• Instructions on how to install BLF-Win

– Hardware and software requirements

– Installation of the BLF-Win server and client software

• An overview of the BLF-Win server functions

2.3  Overview of the BLF-Win 3.0 Product

Feature BLF-Win 3.0

Telephone systems supported by CAP V3.0

Operating systems Please see the Release Notes for current supported Windows versions.

CAP V3.0 connection LAN interface

This overview refers to version 3.0 of the product described in this Service 
Manual:
 P31003-H3231-S100-01-7620, 10/2022
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2.4  Configuring BLF-Win 3.0

2.4.1  Configuring BLF-Win 3.0 using CAP V3.0

The BLF computer is connected to a CAP system via a LAN interface. The BLF-
Win server can run on the same PC as the BLF client, AC-Win and DS-Win. But 
it can also run on a different PC. 
P31003-H3231-S100-01-7620, 10/2022
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2.4.2  Configuring BLF-Win 3.0 using iBLF

The BLF computer is connected to OpenScape 4000 with enabled iBLF via a LAN 
interface. In this case, the BLF server is integrated into the OpenScape 4000 
system.

2.4.3  Implementing Windows 

Throughout this manual we assume that you are familiar with Windows and how 
to use it. For further information on the functions of Windows, please refer to the 
Windows User Manual. 
 P31003-H3231-S100-01-7620, 10/2022
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3  Hardware and Software Installation 

3.1  General Information 

– A BLF PC only supports communication type (LAN).

– The power-save mode must not be enabled on the BLF PC (BIOS setup). 
A screen resolution of at least 1280 x 1024 is recommended as certain 
dialog boxes are not fully visible with lower resolutions.

– Use the „TrueColor“ setting to ensure a correct color display.

3.2  Installing the BLF-Win PC

3.2.1  PC Hardware (Minimum Requirements)

• Processor speed: 1GHz (required for .NET framework)

• RAM: 1GB (512MB for .NET framework, 512MB for BLF Server +Client, 
AC+DS-Win)

• 1 LAN interface

• Disk space: 1.2 GB min.

• Optical drive: CD-ROM drive 16xspin

• Graphics controller 1 MB on board (True Color)

• Monitor resolution of 1280x1024

• KBPC B keyboard

• MS compatible mouse (PS2)

3.2.2  PC-Software 

• AC-Win SL 2Q V3.0, AC-Win SL MQ V3.0

• DS-Win V4

• Bios settings:

• Boot Plug and Play OS=No

• Power=APM=Disabled
P31003-H3231-S100-01-7620, 10/2022
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3.2.3  LAN Card

An Ethernet network card of the type Ether Link 3COM Combo (S26361-F1952-
L1) must be installed in the PC for connecting via Ethernet. The network card 
should be supported by the operating system with the relevant driver software or 
the drivers should be supplied by the card manufacturer.

NOTE:  You must ensure that surfeits do not occur with other hardware with 
regard to interrupts and I/O addresses.

One LAN card is required for the BLF-Win server PC:

1. For the connection to the CAP V3.0 and to the customer LAN (to support BLF-
Win Clients)
 P31003-H3231-S100-01-7620, 10/2022
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3.3  Installing licenses for BLF-Win using OpenScape CTI

When the BLF-Win Client is connecting to a BLF-Win Server instead of the 
integrated BLF Server (iBLF), then a license is required to monitor the stations. 
License management functions are provided under the License Management 
menu in OpenScape CAP Management. The administrator can manage licenses 
for using the OpenScape CTI system: install license keys, display available 
licenses, assign licenses to users, and uninstall license keys. Every BLF-Win 
Client is delivered with 1000 licenses. This means that it is possible to monitor up 
to 1000 station using one BLF-Win Client. If more than 1000 stations have to be 
monitored, additional BLF-Win Clients have to be ordered.

3.3.1  Install Licenses

Licenses are installed via license files. These license files are to be obtained from 
the same source as the OpenScape CAP software. For Unify customers, this 
normally will be the factory delivering the CDs. Based on the purchase and 
delivery information, the administrator will be able to contact a web site at the 
factory to have license files generated for download. In order to prevent misuse, 
license keys are tied to the MAC ID of the OpenScape CAP Management host. 
This is why that MAC ID must be provided as well for license generation.

Please note that demo licenses are provided with the OpenScape CAP delivery; 
these are not tied to a specific MAC ID, and are valid for a limited time period only. 

1. Obtain the license file and store it locally at any convenient place.

2. Select Licenses, and activate Install in the navigation frame.

3. Specify the absolute path of the license file in the dialog box.

4. Click Install to have the license file analyzed and the new licenses 
activated.
P31003-H3231-S100-01-7620, 10/2022
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3.3.2  Display Licenses 

Select Licenses, and activate Show in the navigation frame.

A summary is displayed as shown below.

The Overview table contains information on licensed applications, number of 
installed licenses and number of licenses in use / available, per application. The 
Details table shows specific data on each of the installed license keys.

The MAC ID FF-FF-FF-FF-FF-FF is used to identify demo license keys. The 
period of validity is started by first application of a demo key; accordingly, the 
remaining period of validity is displayed in the overview table in brackets, 
following the number of available licenses.
 P31003-H3231-S100-01-7620, 10/2022
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3.3.3  Assign Licenses

For assigning available licenses to individual users, two approaches are 
supported.

By default, users are granted a license implicitly when they log on to the system 
for the first time. The license is taken from the pool of available licenses and is 
assigned to the user (via user ID in OpenScape User Management) from now on. 
If no license is available any more, the user cannot log on.

Alternatively, devices can be assigned licenses explicitly when they are created 
in OpenScape Device Management (see Chapter 3, “Connection to CAP User 
management”) by the administrator. If no license is available any more, the 
administrator receives an error message during device creation.

1. Select Licenses, and activate Assign in the navigation frame to select 
the assignment policy.

2. For any of the available license keys / applications, tick "implicitly during 
register license" to specify implicit assignment (first come - first served), 
or tick "at device administration" to specify explicit assignment (by 
administrator).

3. Click Save to confirm the selection.
P31003-H3231-S100-01-7620, 10/2022
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3.3.4  Uninstall Licenses 

It may be reasonable at some point in time to remove license keys that have been 
installed before.

1. Select Licenses, and click on Uninstall in the navigation frame to 
uninstall licenses.

2. Select the application for which the license key is to be uninstalled.

3. In case you want to retrieve the licenses about to be uninstalled from the 
users who might have been assigned these licenses before, tick "Delete 
license from users".

4. Click Uninstall to confirm the action.
 P31003-H3231-S100-01-7620, 10/2022
22 BLF-Win, Service Manual

        



BLF_Win_SM_ch03.fm

Hardware and Software Installation

Installation and Administration of CAP V3.0
3.4  Installation and Administration of CAP V3.0

In order to operate BLF-Win 3.0 you need to install the software CAP V3.0 before.

You can find a description of the Installation and Administration of CAP V3.0 on 
the BLF-Win 3.0 CD in the document CAP30_SA_en.pdf.

3.4.1  Configuration of CAP and the Connectivity 
Adapter

BLF Win V3.0 is a CSTA III ASN.1 multi domain / homogeneous application.

In the following only general steps are described to install BLF Win V3.0.

The detailed configuration steps of CAP and of the Connectivity Adapter are 
described in the service manuals "CAP Administration-Installation and 
"Installation and Problem Determination Guide for CA4000".
P31003-H3231-S100-01-7620, 10/2022
BLF-Win, Service Manual 23

         



Hardware and Software Installation

BLF_Win_SM_ch03.fm

Installation and Administration of CAP V3.0
3.4.1.1  Adding a switch connection

1. Choose the Service tab of the main page, and the switch connection menu 
on the left side.

2. Click on the "Add new entry"  icon.

3. Choose the type of the switch you want to connect to. (For example: "HiPath 
4000 V6")

SCC configuration

1. Specify the SCC data in the following window (optional fields are marked).

The field SCC-Id may need special attention.

2. Click on Next>>.
 P31003-H3231-S100-01-7620, 10/2022
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Switch dependent configuration

1. Specify the CA port.

2. Click on Next>>.

The fields IP address of the Switch, Outside line access, Country code, Area 
code and Main number may need special attention.
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3. Click Add.

NOTE:  To synchronize the database with OS4K, after adding the switch 
connection, edit the switch connection, set the SPI (PBX Information Service) 
username and password, and then click "Get device data". For more information 
about SPI, see the OpenScape CAP V3.0 Service Manual.

3.4.1.2  Adding an SCC Proxy

1. Select SSC Proxy menu and click on the "Add New entry"  icon.
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2. Select the SSC Proxy data.
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3.4.1.3  Adding devices

1. On Device tab of the main page select Add.

2. Select the SCC ID from the drop-down. This is the switch connection added 
in Chapter 3, “Adding a switch connection”.

3. Type the extension number in the Extension field.

4. Select a user in the Assigned users field. This field will be the subscriber’s 
name in BLF Client.

5. As default implicit licensing is used for BLF. Click on Add.

6. If explicit licensing is used for BLF, click on Assign licenses...
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7. Select BLF-Win V3.0 in the section Available licenses.

8. Click on Assign license..

9. Click on Close to close the license window.

10. Click on Add to add the specified extension.
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3.4.1.4  Adding users

There are two types of users, that can be added: 

• CTI user (this is the recommended one) or 

• application user

1. Click on Users tab of the main page, then select the Add menu. Check the 
user to be added in the Roles field (either CTI User or Application).

2. Specify a Display name for the user. This will be used as the subscriber 
name in BLF Client.

3. Click on Assign devices and assign the device for the user.
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4. Click on the Add button.

5. Select the devices you want to assign to the user and click on the Assign 
device button or click on the Search device button if the device is not listed 
in the Search result devices field.

6. Click Close.

Additional information can be found in the OpenScape CAP V3.0 Service Manual.
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3.5  Installing BLF-Win software

Prerequisites:

Before the BLF-Win software installation, make sure that the Microsoft .NET 
Framework 4.7.2 or higher is installed on your system. The framework is 
delivered with the Windows operating system. The version can be checked in the 
Command Prompt (as administrator) with the following command: reg query 
"HKLM\SOFTWARE\Microsoft\Net Framework Setup\NDP\v4" /s
 P31003-H3231-S100-01-7620, 10/2022
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1. Run the BLF-Win setup.exe executable file as administrator from BLF-Win 
package. This will extract the setup files into a temporary location and it will 
launch the setup automatically. The setup and application language are 
English, the application language can be changed after the installation.

2. Select what components you want to install: Client, Server or both. A 
destination folder for installing BLF-Win is suggested. It can be changed by 
clicking on Change button. 
P31003-H3231-S100-01-7620, 10/2022
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NOTE:  If iBLF is used, install only the BLF Client component.

3. Click Install.
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34 BLF-Win, Service Manual

        



BLF_Win_SM_ch03.fm

Hardware and Software Installation

Installing BLF-Win software
The installed files with the default locations are: 

• C:\ProgramData\BLF

• Settings – used for configuration files: BLF.ini, *.blf, passfile 

• Logs – the logs will be created here 

• Database – the PERSPORT database will be downloaded here

• C:\Program Files (x86)\BLF-Win\BLF Client\ – location of the 
BLF Client executable file

• C:\Program Files (x86)\BLF-Win\BLF Server\ - location of the 
BLF Server executable file

NOTE:  if the application is launched as a non-administrator user, then the 
settings are stored in: 
C:\Users\<Username>\AppData\Local\Virtual-
Store\ProgramData\BLF\Settings\

3.5.1  Connection setup of BLF-Win Server

If you selected the BLF Server component to be installed, proceed with following 
steps:

1. Start the BLF Server from Windows Start menu.

2. A gray icon of BLF Server will appear in the system tray. The icon changes to 
color when the CAP is connected. Double click on the icon to open the BLF 
Server window.
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3. Select Configuration > CAP Settings.

4. Fill in the CAP server name, SCCP port number (default value is 2205), 
CAP user name, CAP password and CAP HTTP administration port 
number (default value is 8170). Click on Next>. 

NOTE:  The SCCP port address (communication between CAP V3.0 and 
BLF-Win Server) must be the same as the one defined in CSTA Application 
Configuration. 

The administration port number is used to receive user management 
information from CAP server. 

5. CAP V3.0 and BLF-Win Server can be installed on the same PC or on 
different ones (see Chapter 2.4.1). 
Select Configuration > Server settings.

6. Specify the Listening port which will be used for BLF Client connection. 
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3.5.2  Connection setup of BLF-Win Client

If you selected the BLF-Win Client component to be installed, proceed with 
following steps:

1. Start the BLF Client from Windows Start menu.

2. Enter the IP address, port number of the BLF Server, give a Name for the 
connection and check Enabled to establish the connection after the window 
is closed. Click Ok. 

NOTE:  The bottom right corner of the BLF Client will show how many connec-
tions are established from the BLF Server connection list. 
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3.5.3  Uninstalling BLF-Win Client/Server

The uninstallation is always performed depending on the installed components, 
i.e. server, client or both components will be uninstalled. 

1. Click on Start and select Control Panel. Depending on your OS, go to the 
Programs and Features section.

2. Select BLF-Win and click Uninstall.

3. If you run the program as administrator, then the configuration directory is 
C:\ProgramData\BLF. If you run the program as a User, then the configuration 
files are stored in C:\Users\Aron\AppData\Local\ 
VirtualStore\ProgramData\BLF. 
These files must be manually deleted.

3.6  Connection to CAP User management

CAP V3.0 User Management information is taken over by the BLF-Win Server.

You have to setup a daily export from the CAP User Management.

1. Start the CAP Management (default: http://<cappcname>:8170). 

2. Click on Data in the top menu.

3. Choose the 'Scheduled Tasks' in the side menu.

Now you see a list of scheduled tasks (or an empty list). 

4. You have to create new tasks by clicking on the 'Create new timer' icon on 
the title bar.

5. Specify the fields, like you see in the following picture:
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6. Source / Target directory must be the “Database” folder from of the BLF 
Server configuration directory. If the BLF Server is installed on a different PC, 
then this path must be a network location which points to the “Database” 
folder.

7. File name must be “userExported.txt”. This file is processed by the BLF 
Server, then transferred to each BLF client. If a different name than 
“userExported.txt” is used, then it has to be specified in the BLFServer.cfg 
from the BLF Server configuration directory. The CAPDatabaseFile 
parameter is the filename.

8. Save the settings. The file 'userExported.txt' will be created at the time of 
activation.

NOTE:  The database exported by CAP can be different from the database 
exported by the iBLF server running on the same 4K system, because the “User 
and device data” Transfer type uses different parameters than iBLF.

NOTE:  It is recommended to run the BLF-Win Server and CAP on the same PC. 
If CAP and the BLF-Win Server are running on different machines you have to 
make one more change:

To access this network share you have to modify the CAP service 'Log on' 
parameter.

Please follow these steps on the CAP Server to set these necessary parameters:

1. Windows Start->Settings->Control Panel->Administrative Tools-
>Services

2. Select the service "OpenScape CTI"

3. Activate with the pull down menu and select "Properties"

4. Select "Log on" and define an account which has administrator rights for the 
local machine and right to access the BLF-Win Database share
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3.7  Database update with CAP User Management and iBLF
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The picture above shows the interaction of the BLF Client with the CAP-User-
Management and describes which BLF modules have access to the database.

1. Using BLF-Win Server and CAP:

• CAP synchronizes the database with OS4K systems via the PBX 
Information Service (SPI) or uses the current database of CAP 
management and creates the userExported.txt file daily.

• The BLF server converts the file userExported.txt to Persport.txt every 
time its content changes and sends it to the BLF Client.

• The BLF Client renames the file to Persport_<CAP IP>_<BLF Server 
Port>.txt and uses it.

2. Using iBLF Server:

• The iBLF Server synchronizes the database daily with the OS4K it runs 
on and sends the Persport.txt to the BLF Client.

• The BLF Client renames the file to Persport_<CSTA IP>_<BLF Server 
Port>.txt and uses it.

NOTE:  The BLF Client periodically compares the checksum of the local and 
remote database and retrieves the database from the BLF server if necessary. 
Furthermore, the database can be updated manually from BLF Client, selecting 
Tools / Request Database.

Example:

Details of the CAP database: 

The CAP database consists of devices added in CAP (see Chapter 3, “Adding 
devices”). The resulting fields are used by the BLF Client as follows:
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• name – for subscriber’s name (see Chapter 3, “Adding users”)

• countryCode, areaCode, number – for subscriber’s prefix

• nac – reserved field for future development

• extension – for subscriber’s number

Details of the iBLF database:

iBLF synchronizes with the Assistant's PERSPORT table once a day. The 
resulting fields are used by the BLF Client as follows: 

• displayname – for subscriber’s name 

• isdn_cc, isdn_ac, isdn_lc – for subscriber’s prefix 

• vnac – reserved field for future development

• extension – for subscriber’s number

3.8  iBLF Configuration

Please check OpenScape 4000 CSTA and Phone Services, Service 
Documentation, for more information about the iBLF Configuration.
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4  BLF-Win Client

4.1  Main BLF Window

The elements of the main BLF window are presented in the figure below. 

The different states are indicated by different colors, which can be changed from 
Tools > Options > Colors: 
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You can arrange both the subscribers and the subscriber ranges in the display 
field according to your requirements using drag & drop.
You can change the color setting and arrange the subscribers within a subscriber 
range to suit your needs. The BLF-Win user guide contains detailed information 
on this topic.
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5  BLF-Win Server

5.1  Main Window

BLF-Win Server can be started from Start / Programs / BLF / BLF Server.

5.2  Configuration 

BLF-Win Server configuration is split in two section, CAP settings and Server 
settings. For more details, see Chapter 3, “Connection setup of BLF-Win Server”.

5.3  Exiting BLF-Win Server

To exit the program, click File > Exit.
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6  Appendix

6.1  Logging Diagnostic Data

6.1.1  Activate logging for BLF-Win V3.0

To activate logging for BLF Client, change the property ClientLogEnabled to 
YES in C:\ProgramData\BLF\Settings\BLF.ini OR open the BLF Client, 
and select Tools / Options / Log settings. For more information read the BLF-
Win User Guide, section 3.6, “Log Settings”.

To activate logging for BLF Server, change the property ServerLogEnabled to 
YES in C:\ProgramData\BLF\Settings\BLF.ini OR open the BLF Server, 
and select Configuration / Server Settings then tick Enable BLF Server Log.

NOTE:  The BLF Client has a log rotation mechanism, where the file size and file 
number can be changed from the BLF Client log settings. The BLF Server creates 
new log files at every startup.

NOTE:  To activate logging for iBLF, see OpenScape 4000 CSTA and Phone 
Services, Service documentation.

6.1.2  Activate logging for CAP V3.0

In many cases, it can also be helpful to provide information to the BLF 
development department with the CAP logs. For information about modifying the 
configuration files to get detailed traces, see the CAP Service Manual Section 
7.7.7.

The following configuration files must be modified:

<CAP install directory>/config/<PC name>/sccp_<SCCP name>/Telas.cfg

<CAP install directory>/config/<PC name>/telasServer_<SCC name>/Telas.cfg

<CAP install directory>/config/<PC name>/CA4000_<SCC name>/ca4000.cfg 
(for HiPath4000)

Change the following entries:
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log.level = 5 (must be set to "5" in all of the configuration files mentioned 
above)

cstaLogEnabled = 1 (no change for ca4000.cfg)

debugLevel = 9 (no change for ca4000.cfg)

Section 7.7.10 Saving diagnostic data contains information about you save a 
zipped version of CAP logs. 

Invoke with

Internet Explorer > CAP management > Diagnostics > Download Data

Section A.2 of the CAP Service Manual includes a description of the 
configuration files.
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